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This document is a working draft. If you 
find an error, please submit a bug on 
the Quickvol website. Thank you. 
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2.0 Getting started 

2.1 System requirements 
QuickVol II is designed to run on any Java enabled platform. The 
minimum system requirements depend on the size of the data being 
analyzed; generally, the amount of RAM in your workstation is more 
critical than processor speed.  

A Java Runtime Environment of version 1.4.1 or later is required. The 
current JRE Release is 5.0; please see http://www.javasoft.com for 
more information. 

ImageJ (version 1.34s or later) must be installed if you plan to run 
locally. 

Mac OSX and Linux appear to be considerably slower for floating 
point computations, than Win XP. This impedes performance on tasks 
such as Real-Space manipulations of volumes and calculations (T1, T2, 
etc.) Consequently, you may find that windows workstations provide 
better performance overall. 

A windows workstation with 512MB RAM, and a 2.0 GHz processor 
has reasonable performance manipulating eight 15MB fMRI datasets 
simultaneously.  

2.2 Launching directly from the website (Mac OSX, Linux, WinXP) 
It is best to launch QuickVol II directly from the website 
(http://www.quickvol.com) to ensure that you automatically get the 
latest version.  

Note that on all but the most current Linux installations, you will need 
to manually install java web start, and associate the JNLP MIME type 
in your browser (probably mozilla), in order to launch QuickVol II 
directly from the web. You can tell that you need to perform this step if 
after clicking on the launch button, the download window opens, and 
attempts to download and save the *.jnlp file that launches QuickVol 
II. Follow the directions for your browser to add a new MIME type; on 
Mozilla the process should be similar to: 

1) Click on Edit menu --> Preferences (choose Navigator) --> Helper 
Applications.   

2) In the "New Type" window, fill the following information:  

3) Description of type: JNLP  

File extension: jnlp  

MIME type: application/x-java-jnlp-file  

Application to use: <your path to>/javaws 

Click OK button on both New Type and Preferences box. 
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On MAC and Windows platforms, if you have a current version of the 
JRE installed, your default browser should automatically associate the 
JNLP file with Java Web Start when you click on the launch buttons, 
and should automatically launch the application. 

NOTE: Please report a bug on the website if you have difficulty 
launching the application due to MIME types, firewall issues, etc.  

2.3 Downloading and running locally 
You may choose to download the plugin and run locally if, for 
example, you want to use QuickVol II or the other plugins in 
conjunction with additional ImageJ plugins that you have already 
installed, or if you have difficulty configuring your browser to launch 
via Java Web Start. If you choose to download the QuickVol II jar file 
to run locally, unzip the jar file from the bottom section of the launch 
page on the QuickVol website (Figure 1), and place it in the 
plugins/jars folder of your ImageJ installation.  

Note that each time QuickVol II is started, it will attempt to check for a 
newer version by sending an HTTP request to the quickvol website. If 
the network is unavailable, you will receive a message to check for a 
newer version the next time you are online. This is normal behavior, 
and you can dismiss this dialog and continue to run normally. If a 
newer version is detected, QuickVol II will notify you and attempt to 
open a browser to download the current JAR file. Given the frequency 
with which QuickVol II is updated, please take the opportunity to save 
the current jar file and restart ImageJ to ensure that you have the most 
current version of the software. 

Please report a bug if this feature causes problems (long delays when 
starting when not connected to the network, etc.) 

2.4 A note on incompatibility of older (QuickVol I & MRIAnalysisPak) 
plugins with the current version of ImageJ 

Due to the updates in ImageJ since the original QuickVol and 
MRIAnalysisPak plugins were originally developed in 2003, these 
older plugins will only run with older versions of ImageJ, or when 
launched from the quickvol website using Java Web Start. Updates to 
these plugins will be implemented in QuickVol II, but please submit a 
bug or feature request if you experience problems with the 
functionality in these older tools, or would like to see improvements in 
their functionality. 

 

 

Figure 1: Downloading the QuickVol
II jar file to run locally.
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3.0 Other Plugins: Opening MRI Data in ImageJ 
MRI Scan data can be imported manually using ImageJ’s native functionality, 
but several additional plugins available on www.quickvol.com can make this 
task easier for some common MR data formats. 

NOTE: these plugins do not check for newer versions, so if you choose to run 
them locally, you will need to periodically download the plugins to ensure that 
you have the current version. Being lazy, I do not currently track the build 
number on these plugins, and so I do not have a version number to publish for 
comparison. This may change in the future, but until then, please periodically 
update your plugins if you run locally. 

The Bruker Opener plugin is described below, but other plugins for reading 
Stimulate (SDT) files, as well as AFNI are supplied, and their use should be 
self explanatory.  

3.1 Opening Bruker scan data 
The Bruker Opener plugin, while having a somewhat clumsy interface, will 
parse Bruker scan directories to look for reconstructions, and simplify the task 
of opening, renaming, and assigning appropriate dimension information to 
available reconstructions (Figure S1). 

To use the plugin, in the directory chooser window that opens, HIGHLIGHT 
(do not open or descend into) the directory that contains the Bruker scans. The 
plugin will automatically parse the tree of available scans in the directory, and 
display a list of available reconstructions in the window to the right. To open a 

particular reconstruction, 
highlight the reconstruction, and 
click the OPEN button 
immediately below.  

To exit the plugin, you can 
simply close the window, or click 
any of the buttons on the bottom 
of the window. There is certainly 
a more elegant way to do this, so 
if this functionality annoys you, 
please submit a bug on the 
Quickvol website.  

 

Figure S1: Opening Bruker scan data using the Open Bruker Plugin

In the directory chooser that opens, HIGHLIGHT – do not open or descend into – the directory that 
contains the bruker scans. Momentarily, a list of available reconstructions will appear in the small internal 
window on the right, and you can highlight the reconstruction that you want to open, and select the OPEN 
button that IS IMMEDIATELY BELOW the reconstructions to load the 2dseq file with an appropriate 
name and dimension information. NOTE that currently, the TR is not read, and is defaulted to 1.5 sec, so 
you will need to change this manually if you intend to do real space/time re-sampling.
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4.0 Introduction to the user interface 
The QuickVol II user interface is comprised of two primary windows, the 
Control Panel and the 2D Visualization window (Figure 2), and several 
supplemental windows which can be opened during specific tasks, such as 
analyzing a timecourse, manipulating a 3D model, or viewing a legend.  

 The control panel is used to control all of the visualization options, as well as 
perform calculations, and the Visualization Window implements a multislice 
“montage” view of 3D datasets. 

The control panel is divided into 6 general task categories, with a separate tab 
for each. These categories are: 

• Display: This tab contains the controls for the 2D visualization 
window display options, including switching between real space and 
voxel space, and which volumes are displayed on the background 
and foreground. 

•  Data: This tab controls the transformations that govern how the 
voxel data is mapped to real space, and the number of slices / 
repetitions in 3 and 4 dimensional datasets 

• ROI: This tab provides utilities for performing a region on interest 
analysis, and is intended for use primarily with 4D datasets. Please 
use the excellent ROI tools in ImageJ for analysis of 3D datasets. 

• Calc: This tab provides access to the built-in interpreter for 
performing calculations on 3 and 4 dimensional datasets. Several 
common functions, many from the MRIAnalysisPak, are included as 
“ready made” expressions that can be quickly loaded and run on 
open volumes 

• Util: This pane enables several common tasks, such as animation of 
the 2D visualization window, truncation and extraction of repetitions 
from 4D data sets, and the taking of “snapshots” of open windows 
which can be saved as image files in ImageJ. 

• 3D: Legacy QuickVol functionality – this pane enables the creation 
of polygonal models from 3D data or from defined regions of 
interest. The created models display a volume calculation, and can be 
saved into a format for rendering by the 3rd party raytracing 
application, PovRay. 

• Help: Information about QuickVol II and some quick links to the 
website, including bug reporting, and access to this manual. NOTE: 
the buttons which open a new browser window to these URLs do not 
work on Linux. 

4.1 The Display Tab: Controlling the 2D visualization window 
The Display tab provides the necessary controls for the 2D visualization 
window, including the number of panes and how they are displayed (rows and 
columns, background color, which slices are displayed in each pane, the width 
of the border between panes).  

Two volumes can be displayed simultaneously in an overlay fashion, and the 
Background Volume and Foreground Volume options control the color 

Figure 2: The initial interface

When starrted, QuickVol II will open two 
windows, the Control Panel and 2D 
Visualization Window.
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scheme, transparency (alpha), and the optional mask and threshold that is used 
for each.  

Note that interpolation is only relevant when real-space resampling is being 
used.  

Real Space & Time Re-Sampling options include a simple toggle to switch 
between voxelspace and real space and time volume resampling. These 
options define the “slice plan” that will be used to resample the volumes, 
including the resolution (Mat), slice thickness (Thk), Field of View in the 
transverse direction (FOV) and repetition time (TR) when multiple repetitions 
are available.  When enabled, Real Space & Time Re-sampling can used to 
resample volumes on the fly for co-registration of datasets, calculations that 
are performed on transformed datasets, ROI measurement from transformed 
datasets, and 3D surface extraction.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4: Controlling the unwieldy range control

There are 4 values that are important in establishing the 
contrast of the image. They are the min and max display 
values for each of the two LUTs used to render a 
volume. You can adjust these values interactively by 
clicking and dragging various portions of the range 
control, or, more precisely, by clicking on the numbers 
above each of the 4 points on the control, and then 
typing in the exact value that you wish to use. NOTE: if 
you find this control difficult to use, please submit a bug 
on the quickvol website.

Click the number, or Click and drag

Figure 3: The Display Panel

The Display panel is the primary control for loading and 
visualizing data, and for switching the application mode 
from voxel space to real space re-sampling. Two color 
lookup tables (LUTs) are applied to each foreground 
and background volume, and the range of the lookup 
tables (image contrast) is controlled using an interactive 
range control illustrated in the next figure. Note that 
interpolation is only relevant in real-space mode, and 
that, in real-space mode, all computations are done on 
the fly, including those required to generate the images 
displayed in the 2D visualization window. Unless you 
need to operate in real-space mode, you will experience 
better performance if you do not.
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4.2 The Data Pane: controlling volume to real space transformations 
Each volume that is open in ImageJ is assigned two transformations to 
describe the way that voxels map to real space. When operating in 
“real-space” mode, the application uses these transformations to 
resample the volume data.  

The first transformation describes the basic image parameters, such as 
number of slices vs. number of repetitions, as well as the field of view 
in the transverse and slice directions. You can switch the ordering of 
slices if you need to, in order to preserve Left-Right parity in scans that 
were acquired posterior to anterior.  

By default every volume is assumed to be acquired in AXIAL 
orientation – you can change the slice plan orientation on the Display 
tab to resample according to coronal or sagital orientations if 
necessary. 

Supplemental transformations can be used to co-register two volumes 
together (see the relevant section in Basic Tasks), and once you are 
satisfied with the transformation you can save the transformation in a 
file for future use. Note that there is no feature to save the Pixel to Real 
Space transformation, which is usually supplied in the reconstruction 
data from Bruker Scans, or in the SPR file for stimulate scans. Be sure 
to double check these fields when you reload a scan.  

In real-space mode, you can reslice the current volume according to the 
sliceplan defined in the Display tab, and then save the generated 
volume (as an SDT file, for example) for analysis in other applications. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: The Data Tab

The data tab controls the transformations that map voxel
space to real space. Two transformations can be 
manipulated, the Pixel to Real Space transform concerns 
the basic geometry of the original scan, and the 
supplemental transform can be used to co-register this 
volume to a different volume for multi-subject 
calculations, or ROI analysis using ROIs defined on a 
different volume. See the section on co-registration for a 
description of this task.

Supplemental transforms can be saved and re-loaded, so 
that once you co-register a volume to a different volume, 
you can easily re-apply this transformation later, or 
apply the transformation to a different volume that 
shares the same geometry. 

You can also re-slice and export the selected volume 
according to the slice plan, to generate a new 3D or 4D 
dataset for analysis in other applications.
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4.3 The ROI tab: region of interest analysis on timecourse data 
The ROI tab is provided mainly for the analysis of 4D datasets, in 
particular fMRI datasets.  

When you create a new ROI and define the areas on the image which 
comprise it, you must click the ENTER key to record new areas as 
part of the ROI. As you trace out the area with your mouse, you will 
see a line defining the area; when you release the mouse button, this 
line will be converted to a filled area that is yellow in color, like that 
shown in figure 6. To discard this area and start over, simply click with 
your mouse and start defining a new area. If you are satisfied with the 
area shown in yellow, click the ENTER key to add it to the ROI. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6: Defining regions of interest

By clicking the “New” button, you will be given a new ROI which you can rename by clicking over the 
words “New ROI”. You can change the color of this roi by clicking on the colored square to the right. 
To define the ROI, you must first select it (so that it has the red border shown above), then trace the 
areas on the image that you wish to measure. When you lift your mouse, the area will fill with a yellow 
color. YOU MUST HIT THE ENTER KEY TO RECORD THIS AREA AS PART OF THE ROI. 
When you hit the enter key to record the area, the area will be drawn on the image in the selected color 
for the ROI. There is no feature to delete portions of an ROI, you will just need to delete the ROI and 
start again. 
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Once you have defined 1 or more ROIs, you can view a timecourse of 
measurements at different repetitions within your image by clicking the 
“Show Plot” button.  

Note that the Copy Data button will copy the values displayed in the 
Plot Window to the system clipboard, which can be used to copy these 
timecourse measurements into Excel or another application. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7: Viewing the timecourse

When you have defined an ROI or multiple ROIs on a 4D dataset, you can click the “Show Plot”
window to view a 2D plot of the average signal intensity from each ROI at each repetition in your 
dataset. You will probably want to enable the “normalize” feature if you are comparing two or more 
ROIs, this function divides each measurement by the average of the values from this roi measured 
within the baseline range, and displays the result in a percentage change format. Rolling over lines with 
the mouse will highlight the corresponding ROI on the image, and clicking on a line will allow you to 
examine individual timepoints. 
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4.4 The Calc tab: running calculations on your volume data using the 
built in interpreter 

QuickVol II contains an expression parser which can interpret 
mathematical expressions that you can define to manipulate your data. 

Several common calculations are pre-packaged. 

To use a prepackaged calculation, you must make sure that your 
volume data is opened, and that the correct image dimensions are 
supplied.  

Note that if you are working in “real-space” mode, then the 
calculation indices x,y,z, and t will correspond to the “slice-plan”, 
and not to the image space coordinates. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 8: Running pre-packaged calculations

You can perform several standard calculations on your MRI data, such as a T1 Calculation, T2 
calculations, etc. by loading one of the pre-packaged calculations. Once loaded, follow the 
instructions on the Description Pane, and then define all of the necessary operands (which will 
appear in yellow) on the Expression Pane. You must change the x,y,z, and t range variables 
to coorespond to the dimensions of your data. This will be automated in the future, but must 
be done manually now.

For the courageous: you can use the simple examples to start writing your own expressions. Use 
the Func List and Parse Msgs pop up windows to help debug your expressions. Please note that
the lexical analyzer is not very thorough, and it’s easy to cause problems with dangling 
parenthesis and other typos, so please be careful.  
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4.5 The Util tab: creating animations, editing volumes, taking 
snapshots of the visualization windows 

This section is in progress… 

 

To extract a single repetition from a multi-repetition volume into a new 
volume containing one repetition, supply the required information in 
the sub-panel shown below, and click “GO” – if nothing happens, 
check that the frame (which is 1 based, not zero based) corresponds to 
a repetition in the selected 4D dataset. 

 
 

 

 

4.6 The 3D tab: creating 3D models from ROIs or from floating point 
volumes 

In progress 

4.7 The Help tab: Quick links to QuickVol information and bug 
reporting. 

In progress 
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5.0 Specific Tasks 
While this section of the manual is still being developed, please see the 
downloadable videos on the Tutorials section of the QuickVol website.  

If you would like to download the high resolution versions of these tutorials 
please log into the provided FTP server for the (really big) AVI files.  

5.1 Calculating T1 maps from inversion recovery data sets 
A caveat: currently, all of the T1 calculations implemented in 
QuickVol II use a simplex algorithm for regression. The performance 
of this algorithm is poor, both in speed (they are very slow) and 
convergence (affecting the quality of the final T1 map). To combat the 
convergence problems, since some of the calculations/data sets contain 
multiple minima, you may experiment with the values in the bounds 
array and the starting “seed” values of So and T1 in the calculation to 
guarantee a good map. See the specific calculation for details. A 
Levenberg-Marquardt implementation is currently being developed to 
address these problems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 14: Assessing the format of Inversion Recovery data

Shown above is data collected from a Siemens scanner <acknowledgement M @ 
NYU> which has been organized by increasing TI. All voxels contain positive 
values which have been offset by 2048, in this case very near to the level of  
background noise. This can be readily confirmed by drawing ROIs over the 
background and sample, and comparing them in the Plot Window as shown.
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5.1.1 Organizing and assessing inversion recovery data 

Inversion recovery protocols from different scanners typically produce 
differing data sets, requiring some advance knowledge of how the T1 
calculation will need to progress.  

You can use the ROI tool in QuickVol II to determine the 
characteristics of your IR data set (see sections 4.1 & 4.3). Important: 
after you have assembled your TI images into a single stack, be sure to 
edit the Slices vs. # Reps on the Data pane to force QuickVol to 
recognize each TI as a “repetition”. This is the format that the 
calculations expect. If you get an “out of bounds” error when running 
the calculation, verify that your data is in this format, and that the 
number of slices (range of the z variable in the calculation) is set 
correctly. This should be set automatically in the calculation when you 
set the stack to process, but may be set incorrectly if the slices/reps 
have not been corrected for the volume. 

Figure 14 illustrates IR data collected from a Siemen’s scanner. Note 
that the intensity of the background is higher than the image intensity 
of samples during the TIs preceding the zero crossing, but that all 
values are positive. Calculations #2, and #3 are suited for processing 
this data. 

Depending on the protocol, Bruker scanners often generate magnitude 
images, in which the “negative” values of samples excited prior to the 
zero-crossing are mapped to positive image intensity. Calculation #1 is 
suited for handling this data, but this algorithm has multiple minima, 
and the resulting map will likely contain voxels which are assigned 
minimum T1 values, due to improper convergence. A better algorithm 
for these calculations is in development. 

5.1.2 Performing the calculation 

Once the data has been organized into a single volume, with the 
repetitions set correctly to reflect the images acquired at each TI, you 
can run the appropriate calculation (which is very slow – my 
apologies). Figure 15 illustrates some of the parameters that need to be 
set for calculation #3.  

5.1.3 The calculation result 

If completed successfully, the calculation will generate a new image 
which contains 3 components. The first slice (or slices if your data 
contained multiple anatomical slices) contains the fitted T1 parameter, 
the second the parameter So, and the third contains a Q map illustrating 
the goodness-of-fit for the regression at each voxel. The units of the T1 
map will correspond to the units used in the TI array, and should be 
seconds for best results, due to the seed values already present in the 
other operands. Please note that the values of Q may only be used as a 
threshold to exclude regions of poor fit; they are heavily biased. This 
bias is introduced because in the absence of standard deviation 
measurements for each image, the values from all TIs are used to 
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estimate the standard deviation of each voxel. This results in a copious 
overestimation of the standard deviation of voxels containing signal 
from sample which varies more than the background, by the design of 
the experiment.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 15: Setting the parameters for the T1 calculation

Be sure to check that the slices and repetitions are correctly set for your data 
(shown in the upper left window). The Siemens data set shown in figure 14 can be 
used with the IR calculations #2, and #3; the third calculation is shown above. In 
this calculation the user specifies the level of the background, or offset, rather than 
fitting this parameter automatically which is the case in calculation #2. The TIs
must be set as an array of values separated by commas as shown above. To set the 
values of operands (parameters), just click on  the value field, enter the value(s) and 
press the ENTER key. The background can be measured directly from ImageJ by 
using the Analyze->Measure command for an ImageJ ROI drawn over a region not 
containing sample, or, if a known value (like 2048) it can be supplied directly.
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5.1.4 Visualizing the result 

You can use QuickVol II to visualize the T1 map in false color, to get a 
qualitative idea of how well the calculation performed. I recommend 
extracting the Q map into a separate volume so that it can be used as a 
threshold (see section 4.5). 

You can overlay the T1 map on the foreground, using the original scan 
as a background, and set the colors and display of the foreground to 
show enhanced contrast (see section 4.1). Figure 16 shows an example 
of this. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 16: Visualizing the T1 map

Shown above is a false color overlay of the results of the T1 calculation on the original 
background. The foreground (T1 map) has been masked with the Q map that was generated by 
the calculation, which was extracted from the volume into a separate image using the function 
on the “Util” tab.
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5.2 Manual volume co-registration 
In Progress 
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